Note

These slides are for participants of a live WebAIM training and
are not for distribution to others. They contain examples of

(intentionally) inaccessible content that may not make sense out
of context.

Visit webaim.org for articles on many of the topics covered
within these slides.
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Training outline

9:00-12:00 1:00-4:00
* Introduction * Other Accessibility Principles
 Guidelines and Laws — Contrast

— Color use
— Cognitive disabilities
— Converting to PDF
* Creating Accessible Excel

— Formatting sheets

— Images, links, contrast, navigation,
tables

* Evaluating Document Accessibility
* Assistive Technology

* Creating Accessible Documents
— Headings in Word

— Slide layouts and order in
PowerPoint

— Images and alternative text
— Tables, links, lists, columns, language



Is your electronic content accessible?



WCAG 2

* Web Content Accessibility Guidelines
e Versions 1.0 (1999), 2.0 (2008), 2.1 (2018), and 2.2 (2023)

* Principles based
— Perceivable
— Operable
— Understandable
— Robust



WebAIM WCAG 2 Checklist

Operable
Interface forms, controls, and navigation are operable.

Guideline 2.1
Make all functionality available from a keyboard.

2.1.1 Keyboard

O All page functionality is available using the keyboard, unless the
functionality cannot be accomplished in any known way using a keyboard
(e.g., free hand drawing).

0O Page-specified shortcut keys and accesskeys (accesskey should typically be
avoided) do not conflict with existing browser and screen reader shortcuts.

2.1.2 No Keyboard Trap

0 Keyboard focus is never locked or trapped at one particular page element.
The user can navigate to and from all navigable page elements using only a
keyboard.

O All page functionality is available using the keyboard.

2.1.4 Character Key Shortcuts

Olfa keyboard shortcut uses prlntable character keys then the user must be
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https://webaim.org/standards/wcag/checklist

Notable US laws

Section 508 — WCAG 2.0 A/AA

— US federal agencies

Section 504 — WCAG 2.1 A/AA
— Recipients of federal HHS funds

ADA Title Il (state & local government) — WCAG 2.1 A/AA

— Title | (employment), Title Il (private & commercial) — Missing a
technical standard

504 and ADA changes effective spring 2026



Accessibility > Compliance



Check accessibility



Review tab > Check Accessibility

ert Draw Design Transitions Animations  Slide Show

o g% g

Search = Translate Language
Accessibility v v

Accessibility Insights Language Activity




Word and PowerPoint 365 \/\/e bA| M Q

Accessibility Evaluation Guide web accessibility in mind

This guide combines automated checks from the Accessibility Checker in Microsoft Office 365 with a series of manual
checks to help you evaluate and repair common accessibility issues.

First, run the built-in Accessibility Checker. The Accessibility panel will display: ERRORS, WARNINGS, TIPS, and INTELLIGENT
Services. Click on individual results to go to that issue in the document and make the necessary repairs. Then use the
MaNUAL review steps to identify any additional issues.

Headings (Word-only)

Document contains Word Heading TiP: No Headings in Document Add new headings or apply the
Styles (Heading 1, Heading 2, etc.) (Document must be 3+ pages) correct style to visual headings with
Home tab > Styles gallery.

Visual headings USE Word Styles MANUAL: View tab > Navigation Pane | Home tab > Styles gallery. Apply the
(Heading 1, Heading 2, etc.) > Headings tab (Document Map tab | correct heading style to visual

in Mac). Ensure the structure in the headings.

panel matches the visual heading

structure.

Headings do not skip levels (e.g., MaNUAL: Navigation Pane. Check for | Home tab > Styles gallery. Change
Heading 1 to Heading 3). skipped levels. the heading style to the correct level.

Headings are not empty MANUAL: Navigation Pane. Check for | Delete empty headings.
empty lines.

Section Names (PowerPoint-only)

Word and PowerPoint Accessibilitv Evaluation Guide



https://webaim.org/resources/evaloffice/

Assistive Technology

“Assistive technology promotes greater independence by
enabling people to perform tasks that they were formerly
unable to accomplish, or had great difficulty
accomplishing.”

Wikipedia



http://en.wikipedia.org/wiki/Assistive_technology

Do you use a form of
assistive technology?






Screen Reader Users

Types of Assistive Technology Used

Not all screen reader users are s0%
completely blind.
Most have low vision.

— 45% of respondents to our low-
vision survey use a screen reader.

Some users have a reading or
cognitive disability.

Focus on structure and
semantics.

webaim.org/projects/lowvisionsurvey?/#at



https://webaim.org/projects/lowvisionsurvey2/#at

: Testing Web Content for Accessibility We b{A\ | M 9

Test with WAVE
* Run a report at wave.web.
public pages, use the W

problems or features. Click an icon to highlight the
corresponding element and learn more using the Reference
panel.
Use the Details panel to review page issues. Click an icon to find
it in the page. Uncheck icons to hide them.
Turn off Styles to simplify the page view and to check the
ding and navigati rder.
Click the Code button at the bottom of the page to see the page
code with WAVE icons.
Images
= Ensure alterna text (shown in green) conveys the equivalent
content and/or function of the image.
place images of with true
d via €55 images must have a te
Headings and Regions/Landmarks
* Use the Structure panel in the sidebar to review.
* The main heading should usually be an <h1x.
* Ensure the headings and regions/landmarks reflect the page
structure.
= Look for skipped heading levels (e h2= to <h4:
Contrast
= Select the Contrast panel.
o WAVE flags WCAG AA contrast issues in text.
o Non-underlined links r 1 contrast with body text, plus a
change, like underlining, on hover and focus.
* Check colors in WebAIM's contrast checker:

* Manually ch

ARIA

* WAVE flags ARIA with purple icons.

r appropriate use of ARIA roles, states, and properties

(presented in green).

= Ensure ARIA labels and descriptions are correct.

Forms

* Ensure form controls have de:

Links and buttons

= Ensure links and buttons present descripti

Other common WAVE checks

* Page language is specified (e.g., <html lan,

* If there are data tables, ensure table heade:
have the correct scope.

= Look for links with ambiguous i 3

* Ensure the page title is descriptive and succinct.

Use a checklist

Check keyboard accessibility
* The first time testing with Mac, press Contrel + F7 to enable full
oard accessibility
In Safari, select Preferences > Advanced > Accessibility > Press
Tab to highlight each item...
Mavigate the page using only the keyboard:
nents (links, form controls, etc.)

Spacebar: Actival
menu, or scroll the win
Arrow keys: Navigate radio buttons, select/dropdown menus,
sliders, tab panels, tree menus, etc.
Look for mouse-only interaction | rollover menus).
nfirm every focusable element has a board focus
indicator/outline with at least 3:1 contrast.
Ensure any “skip” links work correctly and are visible to sighted
keyboard use
Make sure the navigation order is logical and intuitive
Test dialog and pop-ups. Can you navigate and close the dialog?
s focus return to a logical place?
Modal dialogs must maintain focus until dismissed.
Non-modal dialogs must close when focus is lost.
o Esc should also close all dialogs and menus.

Test content scaling

* In Chrome, press Ctrlfemd and:
+to zoom in (larger)
n out (smaller)

Avold horizontal scrolling unless required for the content
£., a data tab
= Text-only zoom (Re nded) - In Firefox, choo
Zoom > Zoom Text Only. Zoom to 130-150%

Test with a screen reader

cles/voiceover
Focus on navigation, forms, and dynamic content.
Is information presented through ARIA accurate?
Are forms instructio nd error feedback read when
navigating a form?
Are all dynamic changes and updates accessible?

Scan for other issues

= Captions and transcripts for media.
Information does not depend on color, audio, shape, size, or
location.
Animating or updating content or media can aused or
stopped.
No strobing content/video that could cause seizures.

3 WebAIM. All rights reserved.

Structure &
Semantics



WebAIM Quick Reference: Testing Web Content for
Accessibility

Test with WAVE

* Run a report at wave.webaim.org. For very complex or non-public pages, use the WAVE Chrome or Firefox extension
(wave.webaim.org/extension).
o Woatch the overview video on the WAVE homepage.
s  Error icons flag known issues. Other icons identify potential problems or features. Click an icon to highlight the
corresponding element and learn more using the Reference panel.
* Use the Details panel to review page issues. Click an icon to find it in the page. Uncheck icons to hide them.
s  Turn off Styles to simplify the page view and to check the reading and navigation order.
#  (lick the Code button at the bottom of the page to see the page code with WAVE icons.

Images

* Ensure alternative text (shown in green) conveys the equivalent content and/or function of the image.
¢ Look for ways to replace images of text with true text.
* Content conveyed via C55 images must have a text alternative.

Headings and Regions/Landmarks

Use the Structure panel in the sidebar to review.

The main heading should usually be an <h1=.

Ensure the headings and regions/landmarks reflect the page structure.
Look for skipped heading levels (e.g., <h2>to <h4>).

Contrast

* Select the Contrast panel. o WAVE flags WCAG AA contrast issues in text.
o Mon-underlined links need 3:1 contrast with body text, plus a change, like underlining, on hover and focus.
* Check colors in WebAIM's contrast checker: webaim.org/resources/c

Equivalent
Experience



Creating Accessible Documents and
Presentations



Use Headings



Describe sections of
content

Useful reading and
navigating with a
screen reader

One Heading 1 per

page is usually best
(but not required)

Use headings correctly

@ EASY SHORTBRERD

: . Gradually stir flour into the
@ Ingredlents creamed mixture until blended.

= 1 cup butter, softened Pat the dough in the bottom

= 12 cup sugar "~ ofan ungreased 9x13 baking
pan.

Bake at 300 F for 30 to 40
minutes, until just lightly

@ Directions browned.

= 2 1/2 cups flour

1. Preheat the oven to 300 F. . Remove from oven and pierce all

r with a fork.
2. Cream butter and sugar. over with a 1o




Failure — Headings are purely visual

Text is presented U4 EASY SHORTBREAD

visually as a heading,

. Ingredients 3. Gradually stir flour into the
but is not a true

creamed mixture until blended.

= 1 cup butter, softened 4. Pat the dough in the bottom

. . = 12 cup sugar of an ungreased 9x13 bakin
heading in psug g J

pan.
" 2 12 cups flour Bake at 300 F for 30 to 40
. axKe a or (o]
document structure T minutes. until just lightly
Directions browned.

1. Preheat the oven to 300 F. . Remove from oven and pierce all
over with a fork.

2. Cream butter and sugar.




Failure — Incorrect heading hierarchy

Text presented at a ® FASY SHORTBREHD

lower heading level

3 Gradually stir flour into the
V| S u a I |y h a S a @ Ingredlents creamed mixture until blended.
= 1 cup butter, softened . Pat the dough in the bottom
° . = 12 cup sugar of an ungreased 9x13 bakmg
higher heading level .
8 & 2 12 cups flour Ea; £ 300 F for 30 to 40
. . ake a or 0
IN th e d ocume nt . . minutes, until just lightly
Directions browned.

structure. 1. Preheat the oven to 300 F. . Remove from oven and pierce all
over with a fork.

2. Cream butter and sugar.




Another hierarchy failure

Text presented at a O LASY SHORTBREHD

different level

3 Gradually stir flour into the
V| sua I |y h as th e @ Ingredlents creamed mixture until blended.
= 1 cup butter, softened . Pat the dough in the bottom
1 = 12 cup sugar of an ungreased 9x13 baking
same level in the .
= 2 1/2 cups flour pan
document structure el e s
. . . minutes, until just li
@ Directions brownad ISt HGHEY

1. Preheat the oven to 300 F. . Remove from oven and pierce all
over with a fork.

2. Cream butter and sugar.




Not recommended — Headings skip levels

e Skipping heading |
levels is not a WACG @ EBSY SHORTBRERD
failure if the © Elingredients e ended.

hierarc hy is lo g|C al * 1 cup butter, softened 4. Patthe dough in the bottom

= 1/2 cup sugar of an ungreased 9x13 baking
. . pan.
= 2 12 cups flour
* Butitcan Stl” be P . Bake at 300 F for 30 to 40
. . . minutes, until just lightly
confusing and should @ Directions browned.
b e av Old e d 1. Preheat the oven to 300 F. . Remove from oven and pierce

all over with a fork.

2. Cream butter and sugar.




Failure — Text should not be a heading

Text that does not ® EASY SHORTBREED

describe content

3 . Gradually stir flour into the
S h ou | d N Ot b e 3 @ Ingredlents creamed mixture until blended.
= 1 cup butter, softened . Pat the dough in the bottom
I = 12 cup sugar of an ungreased 9x13 baking
heading. P sug pan.

= 2 1/2 cups flour

. Bake at 300 F for 30 to 40
. . minutes, until just lightl
@ Directions browned. Justughty

1. Preheat the oven to 300 F. . Remove from oven and pierce all

over with a fork.
2. Cream butter and sugar.




Failure — Empty heading

Empty headings are
still announced to

screen reader USers,

which can be
confusing.

@ EASY SHORTBRERD

@ Ingredients

= 1 cup butter, softened
= 12 cup sugar

= 2 1/2 cups flour

@ Directions

1. Preheat the oven to 300 F.

Cream butter and sugar.

Gradually stir flour into the
creamed mixture until blended.

Pat the dough in the bottom
of an ungreased 9x13 baking
pan.

Bake at 300 F for 30 to 40
minutes, until just lightly
browned.

Remove from oven and pierce all
over with a fork.




Headings in Word

Nospacing Heading 1 Heading2  [|tl@  subtite

Styles ¥

e Use “Styles” gallery
e Ctrl+Alt+1,2, 0r3

— command + option on Mac
* Title style does not map to a heading



Demo and Practice — Headings in Word



Images and Alternative Text

WebAIM @

web accessibility in mind



WCAG requirement

“All non-text content that is presented to the
user has a text alternative that serves the

equivalent purpose...”



Alternative Text

* Must

— Be equivalent

* Should

— Usually be succinct
e Should not

— Be redundant
— Start with "image of ..." or "graphic of ..."



2 Meondiody o
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ing under a tree
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Charts and data

@ North America

@ Europe
Asia

@ Australia and Oceania
@ Africa/Middle East
@ South America

@® Central America and
Caribbean




Alt text + description

1. Give the image succinct
E G EIERD

2. Provide a detailed description

— In context OR

— Link to the information
(e.g., an appendix)

@ North America

@ Europe
Asia
@ Australia and Oceania
@ Africa/Middle East
\ @ South America

@ Central America and
Caribbean

Respondent Region

. # of % of
Region
respondents respondents

5

Australia and Oceania 3.8%

Africa/Middle East

Central America and
Caribbean
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Alternative Text in Office

Alt Text . x

How would you describe this object and its
context to someone who is blind or low
vision?

- The subject(s) in detail

- The setting

- The actions or interactions

- Other relevant information

(1-2 detailed sentences recommended)

| Alternative text
here

Generate

[] Mark as decorative (J

1. Right-click the image and
choose View Alt Text

2. Enter appropriate alt text in
the field.

DO NOT choose
“Generate alt text for me”



Decorative images in Office

Alt Text

How would you describe this object and its context
to someone whao is blind ar low vision? . .
- The subject(s) in detail * A screen reader will still read

- The setting

- The actions or interactions ”g ra p h iC”

- Other relevant information

e Check “Mark as Decorative”

* PDF will hide images...
— from screen reader users

— In “Reflow” view

Mark as decorative 0




Demo — Adding Alternative Text

WebAIM @

web accessibility in mind



Image placement in Word

* Layout Options must be “In Line
= Layout options With Text” to be consistently
In Line with Text presented to screen reader users.

m_

* Should be accessible when
converted to PDF (but check this

in Acrobat Pro).




Practice — Alternative text



Tables



Data tables

Class Schedule

Class Name Course Number Location
Advanced Website 3IS 5650 3105
Development
Database BIS 3330 8220

Management




Keys to accessible tables

1. Caption (if needed)

— (or heading if a caption isn’t supported)
2. Table headers
3. Table header scope (if supported)

— Column or row



Assign table headers

Heading (in Word) ==l (C|ass Schedule

Management

Class Name Course Number Location
Advanced Website
D ——— =g BIS 5650 B105
Database ol 553330 B220




Fall Semester

Class Name Course Number Location
Advanced Website 3IS 5650 3105
Development
Database EEEL B220
Management
Winter Semester
Class Name Course Number Location
Advanced Website BIS 5650 105
Development
Database EEEL B220

Management




Fall Semester

Class Name Course Number Location
Advanced Website skeso 3105

Development

Database 5B330 B220

Management

Winter §enfester

Class Name CourseflNumber Location
Advanced Website S 0 3105

Development

Database _Ly, p1s 3330 B220

Management




Fall Semester

Class Name Course Number Location
Advanced Website 8IS 5650 3105
Development
Database IEEEL B220
Management

Winter Semester

Class Name Course Number Location

Advanced Website

BIS 5650 B105
Development

Database

R — SINICER]0 B220




Demo — Table headers and styles

Class Schedule

Class Name Course Number Location

Advanced Website

BIS 5650 B105
Development

Database Management BIS 3330 B220




Descriptive Link Text

Click here

Click here for our campus map

Click here for our campus map

Campus map




Editing Link Text

Edit Hyperlink
Link to: Text to display: | ScreenTip...

e Look im:
Existing File
or Web Page ¥ 10 things 2017-2 LT TR
Current
. Folder
=
Place in This
Document Erowsed
Pages
&
Create Mew Recent
Document Files

_lj Address: hitp:/fwww.amazon.com/Essentials-Online-Course-Design-Standarg » Remaove Link
E-mail

Cancel

Right-click > Edit Link > Text to display



Demo — Link text

Essentials of
Online Course Design

For more information on this topic, read A Standards-Based Guide

SECOMD EDITROM

Essentials of Online Course Design: A
Standards-Based Guide-
https://www.amazon.com/Essentials-
Online-Course-Design-Standards-
Based/dp/0415873002

E—
Kristen Sosulski N


https://www.amazon.com/Essentials-Online-Course-Design-Standards-Based/dp/0415873002
https://www.amazon.com/Essentials-Online-Course-Design-Standards-Based/dp/0415873002
https://www.amazon.com/Essentials-Online-Course-Design-Standards-Based/dp/0415873002

Lists

* Bullets: Equal importance

— Can you reorder the items?

* Numbers: Order or hierarchy

"= Bullets and Numbering...




Ingredients
* 1 cup butter, softened

* 1/2 cup sugar
e 21/2 cups flour

EASY SHORTBREAD

Directions

1. Preheat the oven to 300° F.

2. Cream butter and sugar.

3. Gradually stir flour into the
creamed mixture until blended.

4. Pat the dough in the bottom
of an ungreased 9x13 baking pan.

5. Bake at 300 F for 30 to 40 minutes,
until just lightly browned.

6. Remove from oven and pierce all

over with a fork.



Demo - 4 Steps to Create Lists in Office:

-Decide what type of list you should use—bulleted or numbered
-Highlight text

-Choose the correct list type

-Spend the 5 minutes fixing auto-numbering &



Columns

* Ensures proper reading order
 Word: Layout tab > Columns

 PowerPoint: Home tab > Columns
— or “Two Content” layout instead of inserting a second text box.

File Home Insert Design  Layout References  Review View  Acrobat

@ Ijé IE -ﬁ-- Breaks ~ Indent Spacing

. o ~ - } 2 Line Numbers ~ 5= Left 0" efore: 0 pt
Margins Orientation 5Size |Columns| © Line Numbers 2= Left Before: Up

.1-.
I R
s |
.1-.

b Hyphenation ~ =+ Right: 0" After: |10 pt

Page Setup M Paragraph



Headings
Alternative text for images
Links

Lists

Tables
Columns
Captions

Text size
Contrast

Color reliance
Language
Document title
Forms

HETES
Buttons

Demo - Columns



ldentify text language

Most people today can hardly conceive of life without the
internet. Some have argued that no other single invention has
been more revolutionary since Gutenberg's printing press in the
1400s. Now, at the click of a mouse, the world can be “at your
fingertips”—that is, if you can use a mouse... and see the
screen... and hear the audio—in other words, if you don't have a
disability of any kind.

Q



Set correct text language

 Windows: Select the text. On the Review tab, select Language
> Set Proofing Language

— Choose the most “typical” language version (e.g., “Spanish (Spain)”,
not “Spanish (United States)”)

 Mac: Select the text. On the Review tab, select Language

* To set the language of an entire Word Document : Select all
(Ctrl/command + A), then follow the above steps.



Demo — Document Language

Highlight the text, Review tab > Language > Set Proofing Language

Lorsque j'avais six ans j'ai vu, une fois, une
magnifique image, dans un livre sur la Forét
Vierge qui s'appelait "Histoires Veéecues". Ca
representait un serpent boa qui avalait un
fauve. Voila la copie du dessin.




Practice — Tables, links, lists, columns, and language



PowerPoint?

N

INgs |

Where are the Head




Use layouts

* Correct reading order

* Consistent presentation

* Easy navigation in PowerPoint

*Slide “title”= PDF heading




Slide titles and PDF headings

* Only 1 title per slide

* PDF Heading 1
— “Title Slide” layout
— “Section Header” layout
— The first title in a new section

* PDF Heading 2
— Any other slide title



New Slide > Layout

HOME INSERT DESIGN TRANSITIONS ANIMATI

Paste

-

Clipboard Office Theme

1]

Title Slide Title and Content Section Header




Demo — New Slide



Demo — Apply slide layout

Select correct layout

Put “heading” text in the
title placeholder

Move content into the
content placeholder

Title Slide ntant Section Header Two Conten
Camparison e

Content with Caption Picture with Caption




Demo — Apply slide layout

Select correct layout

Put “heading” text in the title
placeholder

Move content into the content
placeholder

Title Slide ntent Section Header Two Conten
Comparison onte

Content with Caption Picture with Caption




View & change object order



Reading Order Pane (Windows-only)

Accessibility

Inspection Results
Errors

> Missing alternative text (4)

Reading Order x

> Missing slide title (12)

Warnings

Use captions for audio and video : .
) — Title 3: Demo — Reading Order

Table has merged or split cells (3) Content Placeholder 12: From t...

Content Placeholder 14: Selecti...
Check reading order

Slide 21
Slide 40

Slide 134 Recommended Actions
Slide 145

Arrow: Right 15: This will open...

El Verify object order N
Other Suggestions
> Duplicate slide f

(i) Learn more




Demo — Reading Order Pane

Accessibility

Inspection Results
Errors

> Missing alternative text (4)

Reading Order x

> Missing slide title (12)

Warnings

Use captions for audio and video : .
) — Title 3: Demo — Reading Order

Table has merged or split cells (3) Content Placeholder 12: From t...

Content Placeholder 14: Selecti...
Check reading order

Slide 21
Slide 40

Slide 134 Recommended Actions
Slide 145

Arrow: Right 15: This will open...

El Verify object order N
Other Suggestions
> Duplicate slide f

(i) Learn more




Content Order in the Selection Pane

The object on a slide's

bottom layer

...1Is read first by a

screen reader.




Mac/Online Option — Selection Pane

Insert Draw Design Transitions  Animations Slide Show Review View Help ACROBAT C_

Selection

En -
New
v Slide -

Show All Hide All

rd - Slides Paragraph Order Objects

Arrow: Right 15

Reading Order

Content Placeholder 14

Group Objects Content Placeholder 12

There's that logo again

Title 3
Reading Org

Selection Pane

Position Objects

yme tab > Arrange > Selection Pane

Inserting items on the page u |(- Align
boxes, etc. can sometimes ca
reading order issues

(Also available on Windows)



Demo — Selection Pane

Insert Draw Design  Transitions  Animations  Slide Show Review View Help ACROBAT ¢

Selection

By -
New

N Slide ~
, : Show All || Hide All
Slides Paragraph Order Objects

Arrow: Right 15
Content Placeholder 14

Group Objects Content Placeholder 12

There's that logo again

Title 3
Reading Org

Selection Pane

Position Objects

e e
Inserting items on the page u E Align
boxes, etc. can sometimes ca
reading order issues




View tab > Slide Master
Master — All slides
Create new “Layout”
Include title placeholder

Check reading order

Slide Master




Practice — Layouts and reading order



Other accessibility principles



Low vision



Images of Text

SOLVE NEWS

ITWITTER




Provide Sufficient Contrast

WebAIM contrast article



https://webaim.org/articles/contrast/

WCAG Contrast Formula

(L1 + 0.05) / (L2 + 0.05)
where
L=0.2126 * R+ 0.7152 * G+ 0.0722 * B
where
R, G, and B =

Rrgp <= 0.03928 then R = R ;:/12.92
else R = ((R.zgg+0.055)/1.055) » 2.4

where
Reras < = Rgpit/ 255
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Level AA Contrast Examples

4.5:1 3:1 - “Large” text
Gray on White 218pt
Purple on White BOLD: 214pt

Red on Yellow
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Exceptions



“Pure decoration”

. SOMETIMES A
KENKESEY S nmmwe NOTION

ie]l Philbrick® ﬂw
2]

mmos::,_" e

....H.m:.__ EE@MWOWQM 3 ,..w 5 m«ddﬁ.}ﬁ.ﬂi ; : W.
© ALL MALADIES - . MUKHERJEE- ém '

=l el S8 S S AT WE TALK ABouT WHEN WE TALK ABOUT LOVE

VINTAGE

BOBERT FAGLES

Alice’s Mvestors inWordurlsnd
“rd Through te Looking Glass

LewisCarrall

ANGLE OF REPOSE
WALLACE STEGNER

Revolutionary Road  Richard Yates

JOHN FANTE
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“Logotypes”

50 most played . AN
songs by genre R A

MUusIC fq--ﬁ""'.“i‘f‘fi. Y o , 7
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Screenshots

Good, Bad and Neutral

Normal Bad Good

Data and Model

Calculation Check Cell Explanatory ...

Output Warning Text
Titles and Headings
Heading 1  Heading 2 Heading 3

Themed Cell Styles
20% - Accentl 20% - Accent2  20% - Accent3

40% - Accentl 40% - Accent2  40% - Accent3
60% - Accentl

Neutral

Input Linked Cell Note

Heading 4 Title Total

20% - Accentd  20% - Accent5 20% - Accent6
40% - Accent4d ~ 40% - Accent6

e

Number Format

Comma Comma [0] Currency

Currency [0]

Percent




WCAG 2.1 — 3:1 Contrast of
“Graphical Objects”

Market Share




“Against Adjacent color(s)”

Market Share

Chrome

Internet Explorer



“...required to understand”

Market Share

Chrome
47%




“...required to understand”

Market Share

Opera Other
Safari 1% 2%
3%

Firefox
20%

Chrome
47%

Internet Explorer
25%



“Use of Color”

The green mushrooms listed here are okay to eat. The red
mushrooms are poisonous.

* Amanita

* Chanterelle
* Porcini

e Shiitake

* Tylopilus



How can we fix this?

The green mushrooms listed here are okay to eat. The red
mushrooms are poisonous.

e Chanterelle
* Porcini
e Shiitake



lcons (with alternative text)

* Amanita 33{
* Chanterelle

* Porcini

* Shiitake

* Tylopilus X



Separate lists

Safe Poisonous
 Chanterelle e Amanita
* Porcini * Tylopilus

e Shiitake



Bold or Italicized text?

 Chanterelle
* Porcini
e Shiitake



Two separate requirements

1. Ensure enough contrast
2. Do not rely on color alone
- Don’t remove underline from links



Multimedia



Captions




Captioning Methods

* Type, then sync
* Captioner

* Automated
(speech recognition)




Descriptive Transcript

ARP194 Battle of Ushant

American Revolution Podcast

ARP194 Battle of Ushant

After Britain and France went to war in the spring of 1778, America became a sideshow to the main event. Britain and
France had been traditional enemies for centuries. Part of it was the whole Catholic-Protestant rift that had divided
Europe. Part of it was conflicting claims over each other’s countries. King George 11 still held the title of King of
France, a claim that dated back more than 400 years. Although the British Channel kept the two kingdoms separated,
there was a continuing rivalry between the two countries that simply would not end.

In the prior decades most of the fighting had been fought
over colonies around the world. Britain and France traded
colonies in wars back and forth. North America was only
one pawn in that larger game of chess.

In the hundred years prior to this war, Britain and France
had faced off in at least five major wars, totaling 39 years of
fighting. These were a continuation of centuries more
fighting between the two kingdoms.

In the Seven Years War, the British Navy had dominated
the French at sea. That was a big reason why France lost
North America. In the intervening years, France focused on
rebuilding her navy to compete with the British. France,

which had three times the nonulation of Rritain thouaht that

Called “Alternative for Time-
based Media” in WCAG

Text-based presentation of
important audio and visual
information

— Does not have to be text-only

Not synchronized



Deaf-blind

 Content accessible to blind users
will generally be accessible to
users who are deaf-blind

— With the exception of media

* Descriptive transcripts provide
media accessibility




WCAG Requirements

Level A

* Captions

* Transcript for audio-only or video-only content
e Audio description OR transcript (if needed)
Level AA

e Audio description (if needed)

* Live audio — Captions

Level AAA

* Descriptive transcript

* Sign language

* Live audio — Transcript



Our recommendation

Level A

* Captions

* Transcript for audio-only or video-only content
e Audio description OR transcript (if needed)
Level AA

e Audio description (if needed)

* Live audio — Captions

* Descriptive transcript

Level AAA

* Sign language

* Live audio — Transcript



Cognitive/Learning Disabilities

Largest disability group.

Most of the earlier principles can make content more
understandable.
— Captions, contrast, color, headings, lists, simple tables, etc.

Because users’ needs vary greatly, we will focus on general
recommendations.



Make Content “Understandable”

e Use plain language

— “readable to users with a lower secondary reading level” (WCAG
JAVAYAY)

— Write for your audience

* Small text negatively impacts readability

— WCAG has no min. text size requirement

* Choose legible fonts



Typefaces and Fonts

| vs | vs |
[vslvs 1

Each new typeface iNTRODUCES
addittonal cognitive overbead.




Descriptive Document Title

Home Tools Acrobat Practice

® 8 Q ls

e Office uses Filename instead of title. Make it descriptive when
you can.
— E.g., descriptive-title.docx
e Titles required in PDF. Add them in Office and they may be
added when converting to the PDF.
— Mac: File application menu (not tab) > Properties > Title
— Windows: File tab > Info > Title



©

Info
New
Open
Save
Save As
Print

Share

| S N

Document Title | Windows

Document1 - Word

Info

Protect Document Properties -

ﬁ Control what types of changes people can Size Not saved yet

Protect make to this document.

Pages
Document ~ 9

Inspect Document

Before publishing this file, be aware that it
Check for | contains:

Issues - Document properties and author's name
Comments Add comments



Document Title | Mac

Documenti Properties

General Summary Statistics Content = Custom

Subject:
Author:  WebAIM
Manager:
Company:
Category:
Keywords:

Comments:

Hyperlink base:

Template: MNormal.dotm

Save preview picture with this document
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